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Introduction 
 
WinControl is a software based application designed for remotely controlling Quartz 
routers. The software application resides on a standard PC as a single stand-alone 
configuration. Multiple control panels can be set-up across multiple PC's using standard 
network topologies. 
 
Typically WinControl is supplied pre-loaded with a configuration based on the customer's 
current installation. However, the WinControl application can be modified or customised at 
any time. 
 
The flexibility and easy configuration of the traditional Quartz remote control panels has 
been carried across into WinControl. It offers a variety of panel styles and configurations, 
from simple to complex. 
 
WinControl is a menu based interface which allows quick and easy navigation. Its 'Edit 
Mode' configuration package allows the user to map the panel layout to suit their specific 
applications and needs. 
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Section 1 
 

OPERATIONAL GUIDE 
 
 
1.  WinControl - Overview 
 
WinControl is designed and developed by Quartz for the remote control of Quartz Routers 
from a PC. 
 
The WinControl application is a software based control panel which can be installed onto 
any PC running Windows 95 or above. Via its serial communications link the PC can 
remotely control a single or multiple routers. 
 
The WinControl application has a similar level of functionality to Quartz's traditional 
hardware based control panels. Multiple panels can be installed across multiple PC's and 
connected together over a standard computer network. The operational section of this 
guide provides a tour through the operational aspects of the WinControl pannel. 
 
WinControl is normally delivered pre-loaded with a configuration reflecting the customers 
current installation and control requirements. But as for most software applications, 
WinControl can also be modified and customised by the user to suite their changing 
needs. The configuration section of this guide provides a step by step tour to changing the 
current set-up of the control panel. 
 
WinControl has five panel templates which can be customised as required. They are: 
 

 1.  XY Panel 
 2.  Single Destination Panel 
 3.  Two Destination Panel 
 4.  Multi Destination Panel 
 5.  Button Per Source Panel 

 
WinControl can be operated by a variety of input devices e.g. touch screen, mouse or 
graphics tablet etc. WinControl also supports, as an option, an integrated live video 
window providing instant verification of the source selection. 
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Section 2 
 
 
2.  Installation 
 
The WinControl application is delivered on 3½ inch floppy disk(s). To install load disk 1 in 
to the PC and click on the 'Install' file. Follow the on screen installation instructions to load 
the application. 
 
2.1.  Initial Configuration 
The WinControl panel program, called WinPanel.exe, uses two initialisation files (.ini) to 
set the configuration of the program. The .ini file called 'WinServer.ini' holds the entries for 
the routing database (sources/destinations/levels etc) and the .ini file called 'WinPanel.ini' 
holds the data relating to the sources/destinations/menus that the user has access to, as 
well as the communications parameters. 
 
2.2.  Generation of the WinServer.ini file 
 

Step 1: Open the WinSetup application (V1.28 or later) and load the ".qrs" file for 
the routing system that the WinControl application will connect too. 

 
Step 2: From the file drop down menu select the entry 'Export Names To 
WinControl'. Select a location to write this file too (normally the directory that the 
WinControl program resides in). This will create a file named 'WinServer.ini' at this 
location. 

 
Step 3: Quit out of WinSetup. 

 
Note: The file generated by WinSetup ('WinServer.ini') is a replacement for a file 
that may already exist. If so you will be asked to over write it, click OK. This file 
ensures that the source/destination and level names for the WinControl program will 
be the same as those generated by WinSetup. 

 
Step 4: Select the 'WinPanel.exe' file form the WinControl folder. The WinControl 
application will open automatically with the pre-configured setting. If a pre-
configured setting is not present the WinControl application will open with a default 
setting. 
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Section 3 
 
 
3.  Pre-Configured Panels 
 
The pre-configured WinControl application automatically loads one of the five panel 
template. The buttons on the template are mapped according to the pre-configured 
configuration file. 
 
The WinControl panel, in its simplest form, will be configured with a number of active 
buttons for destination and/or source selection. A more complex configuration will have a 
number of the active buttons grouped together under a collection of menu buttons. The 
mapping of the pre-configured panel will be unique, however, the functionality of the 
buttons, and menus etc will be consistent and follow the functionality described within this 
guide. 
 
Please refer to Section 4 'WinControl Panel Functionality' for operational information. 
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Section 4 
 
4.  WinControl Panel Functionality 
 
The functionality of the WinControl panel depends upon the configuration of each 
individual WinControl panel. 
 
Section 4 looks at the various types of buttons that can be used as part of the panel 
configuration and gives an overview of its functionality. 
 
4.1.  Button Types 
Each of the buttons within the WinControl panel can be configured to have the following 
functionality: 
 

4.1.1.  'Unused' 

 
The 'Unused' active button has no functionality and is displayed on the panel as a 
blank space. This button type is useful for creating gaps between different types of 
buttons on the panel, for example between active and menu buttons. 

 
4.1.2.  'Destination Key' 

DEST 01
 

The 'Destination Key' is used for selecting the router destination to which the 
selected source will be switched too. The 'Destination Key' button displays a black 
text label which is normally the destination name or code. The destination name or 
code is defined in the WinSetup application. 

 
4.1.3.  'Source Key' 

SRC 01
 

The 'Source Key' is used for selecting the router source. In 'Source Key' mode the 
selected source is switched to the selected destination the instant the 'Source Key' 
button is selected. In this mode the selected source is not shown in the Preset 
Source Window on the panel and the panel Take button is inoperative. The 'Source 
Key' button displays a red text label which is normally the source name or code. 
The source name or code is defined in the WinSetup application. 

 
4.1.4.  'Source Preset Key' 

SRC 02
 

The 'Source Preset Key' is used for selecting the router source. In the 'Source 
Preset Key' mode the selected source is only switched to the selected destination 
once the 'Take' button has been selected. In this mode the Preset Source window 
confirms the selected source by displaying the selected source name or code. The 
'Source Preset Key' button displays a blue text label which is normally the source 
name or code. The source name or code is defined in the WinSetup application. 
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4.1.5.  'Menu Key' 

MENU 01
 

The 'Menu Key' is used to group together common sources, destinations etc. under 
a single panel button, for example, VTRs, or Video Servers, or graphic devices etc. 
Multiple menu buttons can be linked together to create a cascaded menu structure. 

 
4.1.6.  'Take Key' 

TAKE
 

The 'Take Key' is used to initiate the switch of the selected source through to the 
selected destination. The Take button is only used with buttons configured in the 
Source Preset mode. 

 
4.1.7.  'Salvo Key' 

SALVO
 

The 'Salvo Key' allows multiple functions to be switched together as one. 
 

4.2.  'Destination Lock' 
Lock

 
The 'Lock' button protects the currently selected destination from being switched to 
another source from the control panel. However, the Lock can be removed by a 
user from another control panel or automation system. 

 
4.3.  'Destination Protect' 

Protect
 

The 'Protect' button protects the currently selected destination from being switched 
to another source. It also prevents the selected destination from being changed by 
any other user. 

 
4.4.  'Levels' 

LEVEL
 

The 'Level Key(s)' allows each of the routing levels, video, audio, data etc., to be 
independently selected and turned on or off. 

 
Further operational information relating to each of the panel templates can be found in 
section 5 of the Operational guide and in the Configuration Guide. 
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Section 5 
 
 
5.  Panel Templates 
 
WinControl has five panel templates, anyone of which can be selected, however, only one 
panel can be active at anyone time on the same PC. An alternative panel template can be 
selected and loaded from the 'Panel Operation Options' window at any time. 
 
The 'Panel Operation Options' window is accessed through the 'Options' drop down menu. 
All of the facilities within the 'Option' menu are password protected preventing 
unauthorized entry. 
 
5.0.1  Password Entry 
Access is gained by entering the password from within the 'Edit' menu which will turn on 
the edit mode of the application. 
 

 Step 1.  Click the 'Edit' tab 
 Step 2.  Highlight 'Edit Mode' and click 'On' 
 

A prompt will appear for the password. Enter the password and click 'OK'. The default 
password is "Symbolic". Once access has been gained the password can be changed 
from the 'Edit' menu. 
 
Once in the edit mode the 'Options' drop down menu is enabled. To enter the 'Panel 
Operation Options' window follow these steps. 
 

 Step 1.  Click the 'Options' tab 
 Step 2.  Click 'Panel' 
 

The following window will appear, figure 1. 
 

Panel Template Selection

 
Figure 1 

 
The 'Panel Layout' section of this window allows one of the five panel types to be selected. 
Click on the panel type to select a new template. 
 



WinControl Operation & Configuration Guide 

11 
Manual-10-USER (WinContol)  V1–- Dec 2002 

 
5.1.  XY Panel 
 
The XY panel, figure 2, provides the operator with access to the source and destination 
locations through two display 'panes'. 
 

Destination window

Preset Source window

Take button

Source Selection pane Destination Selection pane

Lock & Protect buttons

Level Status window

 
Figure 2 

 
The XY panel is divided up in to five main areas. 
 
5.1.1.  Source Selection Pane 
The Source Selection Pane provides access to all of the router sources. A scroll bar gives 
access to the source buttons which are out side of the viewable area of the display. In the 
Source Preset Mode the next selected source is displayed in the Preset Source Window. 
 
5.1.2.  Destination Selection Pane 
The Destination Selection Pane provides access to all of the router destinations. The scroll 
bar gives access to the destination buttons that are out side of the viewable area of the 
display. The selected destination is shown in the Destination Window. When a destination 
is selected the source that is currently linked to that destination is shown in each of the 
'Level Status' windows. The Level Status windows also indicate any level breakaways, see 
section 5.1.4. for further information. 
 
The 'Lock' button protects the destination from being switched to another source. 
However, the 'Lock' can be removed by user from another panel. The 'Protect' button locks 
the destination and prevents it from being unlocked by any other user. 
 



WinControl Operation & Configuration Guide 

12 
Manual-10-USER (WinContol)  V1–- Dec 2002 

 
5.1.3.  Destination window 
The Destination Window shows the last, or currently selected router destination. The 
Lock/Protect button prevents the source currently switched to that destination from being 
accidentally changed. See section 4.2. and 4.3. for further information on Locks 
 
5.1.4.  Level Status window 
The Level Status Windows displays the source that is currently switched to the selected 
destination. Figure 3 shows that on all three levels 'source 1' is routed through to 
'destination 1'. 
 

 
Figure 3 

 
The switches set below the Level Status Windows allow each of the levels to be 
independently selected on or off. Figure 4 shows that both of the audio levels have been 
deselected which means that only the video level has been switched to 'source 2'. The text 
in the window for the two audio levels has turned yellow to indicate a level breakaway. 
 

 
Figure 4 

 
Figure 5 shows that the video level has been deselected allowing only the audio levels to 
be switched to 'source 2'. The text in the window for the two audio levels has turned yellow 
to indicate a level breakaway. 
 

 
Figure 5 

 
Figure 6 shows that the video level and each of the audio levels have been switched to an 
independent source. Once again the text in the window for the two audio levels has turned 
yellow to indicate a level breakaway. 
 

 
Figure 6 
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5.1.5.  Preset Source window 
 
The Preset Source Window displays the currently selected source when the source button 
has been configured as a 'Preset Source Key' for example: 
 

 
 

Blue text displayed on the source button indicates it has been configured in the 'Source 
Preset Key' mode. In this mode the Preset Source window shows the currently selected 
source and requires the 'Take' button to be selected in order for the route to be switched. 
 

 
 

Red text displayed on the source button indicates it has been configured in the 'Source 
Key' mode. In this mode the route will be switched as soon as the source button is 
selected. In this mode the selected source is not shown in the Preset Source Window and 
the Take button will be inoperative. 
 
5.1.6.  Selection Box(s) 
By selecting the relevant tick boxes, figure 9, on the Panel Operation Options window 'drop 
down' selection boxes will appear under the Destination and Preset Source window of the 
XY panel, see figure 10. 

Selection Boxes

 
Figure 9 

 
These drop down boxes provide an alternative to the Source and Destination selection 
panes for selecting the required source and/or destination. 
 

"Drop Down" Selection Boxes

 
Figure 10 

 



WinControl Operation & Configuration Guide 

14 
Manual-10-USER (WinContol)  V1–- Dec 2002 

 
5.2.  Single Destination Panel 
 
The Single Destination Panel, figure 11, provides the operator with access to the source 
locations through a single display pane. These sources can only be switch through to a 
single pre-configured destination. 
 

Destination window Preset Source window

Take button

Source Selection pane

Lock & Protect buttons

Level Status window

"Next" Source Currently Selected Source  
Figure 11 

 
The Single Destination panel is divided up in to four main areas. 
 
5.2.1.  Source Selection 
The Source Selection pane provides access to the router sources. The currently selected 
source button is highlighted red while the next selected source is indicated by a blue box 
around the button. With the source buttons configured in the Preset Source mode the next 
selected source is also displayed in the Preset Source Window. 
 
5.2.2.  Destination window 
The Destination Window shows the pre-configured destination. The Lock/Protect button 
prevents the source currently switched to that destination from being accidentally changed. 
See section 4.2. and 4.3. for further information on Locks  
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5.2.3.  Level Status window 
The Level Status Windows displays the source that is currently switched to the pre-
configured destination. Figure 12 shows that at all three levels 'source 1' is routed through 
to 'destination 1'. 
 

 
Figure 12 

 
The switches set below the Level Status Windows allow each of the levels to be 
independently selected on or off. Figure 13 shows that both of the audio levels have been 
deselected which means that only the video level has been switched to 'source 36'. The 
text in the window for the two audio levels has turned yellow to indicate a level breakaway. 
 

 
Figure 13 

 
Figure 14 shows that the video level has been deselected allowing only the audio levels to 
be switched to 'source 4'. The text in the window for the two audio levels has turned yellow 
to indicate a level breakaway. 
 

 
Figure 14 

 
Figure 15 shows that the video level and each of the audio levels have been switched to an 
independent source. Once again the text in the window for the two audio levels has turned 
yellow to indicate a level breakaway. 
 

 
Figure 15 
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5.2.4.  Preset Source window 
The Preset Source Window displays the currently selected source when the source button 
has been configured as a 'Preset Source Key' for example: 
 

 
 

Blue text displayed on the source button indicates it has been configured in the 'Source 
Preset Key' mode. In this mode the Preset Source window shows the currently selected 
source and requires the 'Take' button to be selected in order for the route to be switched. 
 

 
 

Red text displayed on the source button indicates it has been configured in the 'Source 
Key' mode. In this mode the route will be switched as soon as the source button is 
selected. In this mode the selected source is not shown in the Preset Source Window and 
the Take button will be inoperative. 
 
5.2.5.  Selection Box(s) 
By selecting the relevant tick boxes, figure 16, on the Panel Operation Options window 
'drop down' selection boxes will appear under the Preset Source window of the Single 
destination panel, see figure 17. 
 

Selection Boxes

 
Figure 16 

 
The drop down box provides an alternative to the Source selection pane for selecting the 
required sources. 
 

"Drop Down" Selection Box

 
Figure 17 
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5.3.  Two Destination Panel 
 
The Two Destination Panel, figure 18, provides the operator with access to the source 
locations through a single display pane. These sources can only be switched to one of two 
pre-configured destinations. 
 
 

First Destination window

Source Selection pane

"Dest 1" Take button

Second Destination window

"Dest 1" Take button

 
Figure 18 

 
 
The Two Destination panel is divided up in to two main areas. 
 
5.3.1.  Source Selection 
The Source Selection pane provides access to the router sources. The 'next' selected 
source is indicated by a blue box around the button. 
 

 
 

Blue text used for the source buttons indicates that they have been configured in the 
'Source Preset Key' mode. In this mode the source is first selected and then the 
destination button is selected. This then instantly switches the selected source through to 
the selected destination. There is no preset window or 'Take' button. 
 

 
 

Red text in the source buttons indicates that the source buttons have been configured in 
the 'Source Key' mode. In this mode the route will be switched as soon as the source 
button is selected to the active destination. The active destination is the last one of the two 
to be selected. In this mode it is recommended that the required destination is confirmed 
by its re-selection before the source is selected. 
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5.3.2.  Destination Status window 
The Two Destination Panel has a display window and button for each of the two pre-
configured destinations. The windows display the source currently switched through to that 
destination. The display is updated when the new route is switched. 
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5.4.  Multi Destination Panel 
 
The Multi Destination Panel, figure 19, provides the operator with access to the source 
locations through a single display pane. These sources can only be switched to one of 
twelve pre-configured destinations. 
 

Level Selection Preset Source window

Source Selection pane

Destination window & Take button

"Next" Selected Source  
Figure 19 

 
The Multi Destination panel is divided up in to four main areas. 
 
5.4.1.  Source Selection 
The Source Selection panel provides access to the router sources. The next selected 
source is indicated by a blue box around the button as well as being displayed in the 
Preset Source Window as long as the source button has been configured in the Preset 
Source mode. 
 
5.4.2.  Destination Status window 
Each of the twelve pre-defined Destination Status windows displays the source currently 
switched to that destination. The display only changes when the new route is switched. 
 
5.4.3.  Level Selection 
The Level Selection buttons allow the video and audio levels to be independently selected 
before the new route is switched. Level breakaways are not displayed in this configuration. 
 
5.4.4.  Preset Source window 
The Preset Source Window displays the currently selected source when the source button 
has been configured as a 'Preset Source Key' for example: 
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Blue text used for the source buttons indicates that it has have been configured in the 
'Source Preset Key' mode. In this mode the source is first selected and then the 
destination button is selected. The source is then instantly switched through to the 
selected destination. The selected source is displayed in the preset window. 
 

 
 

Red text in the source buttons indicates that it has been configured in the 'Source Key' 
mode. In this mode the route will be switched as soon as the source button is selected to 
the active destination. The active destination is the last one of the twelve to be selected. In 
this mode it is recommended that the required destination confirmed by its re-selection 
before the source is selected. 
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5.5.  Button Per Source Panel (BPS) 
 
The Button Per Source panel provides the operator with access to the source locations 
through a single display pane. The selected source is switched through to a single pre-
configured destination. The BPS panel is the simplest style of control panel. The panel has 
no preset source or destination displays or the ability to select level breakaways. 
 

Selected Source

Source Selection paneSelected Source window  
Figure 20 

 
The BPS panel is divided up in to two main areas. 
 
5.5.1.  Source Selection 
The Source Selection panel provides access to all of the router sources. The next selected 
source is instantly switch through to the destination. The selected source is displayed in 
the Selected Source Window and the source button is highlighted red. 
 
5.5.2.  Destination 
The BPS panel switches the selected source through to a pre-configured destination. The 
BPS configuration does not display any destination or level information other than the red 
highlight on the selected source button. 
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Section 6 
 
 
6.  Menu Buttons 
 
6.1.  Single and Cascaded 
Menu buttons are used to group together common sources and/or destinations, for 
example instead of mixing together active buttons for VTR's, Video Servers, Graphic 
devices etc. within the same pane they can be split in to common groups with a collective 
heading. This speeds up the selection of a source or destination within a large and 
complex router installation. 
 
Figure 21 shows a source pane from the XY panel. The pane titled 'primary sources', is a 
top layer menu. This layer then supports a number of mid layer menus and active buttons. 
The menu buttons are shown on the first row and are displayed with red text. The active 
buttons are on the lower four rows and are displayed with blue text to show which also 
indicates that they are configured as Preset Source buttons.  
 

Top Layer  Menu
Active ButtonsMenu Button

 
Figure 21 

 
6.3.1.  Using Single Layer Menus 
Figure 22 shows the operation of a single layer menu structure. 
 

Top Layer Menu Single Layer Menu

Single Layer Menu

Single Layer Menu

Active Buttons

Active Buttons

Active Buttons

Active Buttons

Active Buttons

Active Buttons

Active Buttons

Active Buttons

Single Layer Menus

 
Figure 22 



WinControl Operation & Configuration Guide 

23 
Manual-10-USER (WinContol)  V1–- Dec 2002 

 
Selecting the single layer menu, in this example 'Studio', reveals the active buttons that 
are linked to the 'Studio' menu group. 
 
At the bottom of the pane is an additional menu button that returns the display to the top 
layer menu display, Primary Sources. 
 

'Mid Layer' Menu

Return - 'Top Layer ' Menu

Active Buttons Selected Menu

 
Figure 23 

 
6.3.2.  Using Cascaded Menus 
Figure 24 shows the operation of a cascaded menu structure. 
 

Top Layer Menu Mid Layer Menu

Mid Layer Menu

Mid Layer Menu

Sub Layer Menu

Sub Layer Menu

Sub Layer Menu

Sub Layer Menu

Active Buttons

Active Buttons

Active Buttons

Active Buttons

Active Buttons

Active Buttons

Active Buttons

Active Buttons

Cascading Menus

 
Figure 24 

 
From the top layer menu selecting the mid layer menu reveals a new set of menu buttons, 
the 'sub layer' menus. The sub layer menus then open out to reveals the active buttons. 
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Figure 25 shows the cascaded menu as shown on the WinControl pane. The 'VTRs' menu 
has been selected revealing the layer of sub menus, Digital Beta, Beta SP etc. At the base 
of the pane is a menu button that returns the display to the top level menu. 
 

'Mid Layer' Menu
Selected Menu Sub Menus

Return - 'Top level' Menu
 

Figure 25 

 
Selecting one of the sub layer menus, for example 'Digital Beta', reveals the active buttons 
that are associated with that menu, figure 26. 
 
At the base of the pane are two additional menu buttons, 'Source' which returns the 
display to the top layer menu and 'VTR's' which returns the display to the mid layer menu. 
 

'Sub Layer' Menu
Selected Menu Active Buttons

Return - 'Top Layer' Menu

Return - 'Mid Layer' Menu
 

Figure 26 
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Section 7 
 
 

CONFIGURATION GUIDE 
 
Up to now the WinControl guide has looked at the operation of the WinControl application 
using standard or basic configurations  
 
The configuration section of the guide looks at the WinControl application and reviews the 
optional features of the application and how the panel can be customised through the 
panels edit mode. It also introduces the concept of menus and the creation of single and 
cascaded menu structures. 
 
7.  'Drop Down' Menus 
 
The WinControl application has a number of 'drop down' menus which allow the current 
panel configuration to be optimised and customised. Some of the menus are password 
protected. 
 
7.1.  'Panel' Menu 
 

 
Figure 27 

 
•  Minimise: The Minimise feature allows the panel to be stored out of they 

way when not in use but to still be accessible when required. 
•  Panel Lock: The Panel Lock button protects all of the destinations from 

being accidentally switched to another source. 
•  Quit: The Quit function closes the WinControl application. 

 
7.2.  'Settings' Menu 
 

 
Figure 28 

 
•  Clear Preset On Take: This function clears the selected source from the 

Source Preset window when the 'Take' button is selected. 
•  Clear Preset On Destination: This function clears the selected source from 

the Source Preset window when a destination is selected. 
•  Clear Destination On Take: This function clears the destination window 

when the 'Take' button is selected. 
•  Auto Find: Not Currently Used. 
•  Save Settings/Position: This function saves the current panel settings. 
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7.3.  'Options' Menu 
 

 
Figure 29 

 
•  Communications: This menu allows the communication parameters to be 

set, for example the PC serial port, the baud rate, the TCP/IP address etc. 
•  Panel: This menu provides access to the Panel Operation Options window. 

See 'Panel Operation Options' section for further details. 
•  Auto Save Menus: This menu allows edited changes to the panel 

configuration to be automatically saved. 
 
7.4.  'Edit' Menu 
 

 
Figure 30 

 
•  Edit Mode: The edit mode menu allows the panel editor to be turn on of off. 

A password is required to enter the edit mode. 
•  Password: The default password can be changed from this menu. 
•  Menus: The 'Menus' window provides access to the control panel edit 

menus. See the 'Edit Menu' section for further details. 
•  Save: This menu allows edited changes to the source and/or destination 

panes to be saved. 
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Section 8 
 
 
8.  Panel Operation Options window 
 
The 'Panel Operation Options' window provides access to a number of menus used for 
configuring and/or customizing the WinControl panel. It is accessed through the 'Options' 
drop down menu. 
 
The 'Panel Operation Options' window is password protected. Access is gained by 
entering the password from within the 'Edit' drop down menu. To enter a password: 
 

 Step 1.  Click the 'Edit' tab 
 Step 2.  Highlight 'Edit Mode' and click 'On' 
 

Enter the password and click 'OK'. The default password is "Symbolic". The password can 
be changed from the 'Password' section of the 'Edit' drop down menu. 
 
To enter the 'Panel Operation Options' window follow these steps. 
 

 Step 1.  Click the 'Options' tab 
 Step 2.  Click 'Panel' - the 'Panel Operation Options' window will appear. 
 
8.1.  Panel Layout 

Panel Layout (Types)

 
Figure 31 

 
The 'Panel Layout' window provides access to the five different templates for the control 
panels supported by WinControl. These are: 
 

1. XY 
2. Single Destination 
3. 2 Destination 
4. Multi Destination 
5. Button Per Source (BPS) 

 

A new panel template is selected by clicking on the name of the required panel. 
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8.2.  Display Settings 
The Display Settings allow a number of additional control features and a built in preview 
video screen to be selected and added to the WinControl panel. 
 

Display Settings

 
Figure 32 

 
8.2.1.  Source and Destination selection Boxes 
When selected the Source and Destination selection boxes add additional drop down 
boxes to the control panel, figure 23. These drop down boxes provide an alternative to the 
Source or Destination selection pane and allow access to sources and destinations that 
are not part of the panel configuration. 
 

"Drop Down" Selection Boxes

 
Figure 33 

 
8.2.2.  Preview Window 
The 'Show Preview Window' enables the video preview output of the router to be displayed 
on the WinControl panel via a video card installed within the PC. This removes the need 
for a separate video monitor. 

'Preset Source' Video Display

 
Figure 34 
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8.3.  Default Settings 

Default Settings

 
Figure 35 

 
The panel templates which include destination displays are pre-loaded with a configuration 
that determines which destination is selected and which levels are active when the 
application is loaded. These settings are configured through the 'Panel Operation Options' 
menu. This is done by selecting the corresponding window from the 'Window' drop down 
list and selecting a new destination from the 'Bus' drop down list. Each of the levels can be 
enabled or disabled by highlighting the required levels in the 'Levels' window. 
 
8.4.  Preview Bus Options 

Preview Bus Options

 
Figure 36 

 
A router destination can be set as a preview output which is fed through to a preview 
monitor. The 'Preview Bus Options' menu allows the parameters of this output to be set. 
For further information see section 8.2.2. 
 
The 'Mode' defines the functionality of the preview output. 
 

1. Follow Preset Source: In this mode the video and audio source shown on the 
preview bus will change with the selection of the Preset Source. 

2. Follow Current Destination: In this mode the video and audio source shown 
on the preview bus will change with the selection of the destination. 

 
The levels of the preview output, such as the video and audio, can also be selected from 
the list. 
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Section 9 
 
 
9.  Edit Menus 
 
The 'Edit Menus' window provides access to the configuration menus used for setting up 
and/or customizing the WinControl panel. 
 
The 'Edit Menus' window is password protected. Access is gained by entering the 
password from within the 'Edit' drop down menu. To enter the password: 
 

 Step 1.  Click the 'Edit' tab 
 Step 2.  Highlight 'Edit Mode' and click 'On' 

Step 3.  Enter the password and click 'OK'. 
 

The default password is "Symbolic" The password can be changed from the 'Password' 
section of the 'Edit' drop down menu. To enter the 'Edit Menus' window follow these steps. 
 

 Step 1.  Click the 'Options' tab 
 Step 2.  Click 'Panel' 
 

The 'Edit Menus' window will appear, figure 37. 
 

Menus

 
Figure 37 

 
The WinControl panel is built on menus. Even the most simple panel configuration 
requires a menu. 
 
The menu defines the title of the Pane, the name of the button that links to the menu (if 
required) and the number of active buttons within the menu. From this the rest of the 
WinControl panel is configured. 
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9.1.  Creating a base menu 
A 'Menu' is created within the 'Edit Menus' window by clicking the 'Add' button. The menu 
is added to the library list and is shown with a default name, title and a value of zero for the 
number of active buttons, figure 38. 
 

New Menu

 
Figure 38 

 
The properties of the menu, such as name, title and number of buttons, are entered via the 
text boxes in 'Menu Properties'. In this example, which is for an XY panel configuration, 
two menus have been created, one for the source pane and the second for the destination 
pane, both have been configured with 36 active buttons, figure 39. 
 

 
Figure 39 

 
9.2.  Default Panel Menus 
Checking the 'XY Left Pane' and 'XY Right Pane' tick boxes sets the primary source and 
primary destination menus as defaults, figure 40. These two menus will be used to 
configure the XY panel as the WinControl application loads. 
 

 
Figure 40 
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Once the base menus have been created the active buttons of the control panel can then 
be defined. The WinControl application uses the source and destination information from 
the WinSetup application to configure the active buttons for both the source and 
destination panes. Figure 41 shows a basic XY panel configuration with the two panes 
showing the active source and destination buttons. 
 

Source Selection pane Destination Selection pane
 

Figure 41 

 
9.3.  Menu Buttons - Single and Cascaded 
The menus for the WinControl application can also be used to group together common 
sources and/or destinations on the pane. For example instead of mixing together active 
buttons for VTR's, Video Servers, Graphics systems etc. within the same pane they can be 
split in to common groups, and stored under a single collective heading. This speeds up 
the selection of source or destination locations within a large and complex router 
installation. 
 
This section looks at the implementation of these menu buttons and their operation. 
 
Figure 42 shows a source pane from the XY panel. The menu, 'primary sources', is the top 
layer menu. This layer then supports the mid layer menus and active buttons. The menu 
buttons are shown on the first row and are displayed with red text. The active buttons are 
on the lower four rows and are displayed with blue text to show that they are configured as 
Preset Source buttons.  

Top Layer  Menu
Active ButtonsMenu Button

 
Figure 42 
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9.3.1.  Single Layer Menu 
Figure 43 shows the operational work flow of a single layer menu structure working from the 
top layer menu through to the active buttons. 
 
 

Top Layer Menu Single Layer Menu

Single Layer Menu

Single Layer Menu

Active Buttons

Active Buttons

Active Buttons

Active Buttons

Active Buttons

Active Buttons

Active Buttons

Active Buttons

Single Layer Menus

 
Figure 43 

 
 
Selecting the single layer menu, in this example 'Studio', reveals the active buttons that 
are linked to that selected menu group. 
 
At the bottom of the pane is an additional menu button that returns the display to the top 
layer menu. 
 

'Mid Layer' Menu

Return - 'Top Layer ' Menu

Active Buttons Selected Menu

 
Figure 44 
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9.3.2.  Cascaded Menus 
Figure 45 shows the operational work flow through a cascaded menu structure from the top 
layer menu through additional menus to the active buttons. 
 
 

Top Layer Menu Mid Layer Menu

Mid Layer Menu

Mid Layer Menu

Sub Layer Menu

Sub Layer Menu

Sub Layer Menu

Sub Layer Menu

Active Buttons

Active Buttons

Active Buttons

Active Buttons

Active Buttons

Active Buttons

Active Buttons

Active Buttons

Cascading Menus

 
Figure 45 

 
 
Selecting the cascaded layer menu reveals a new set of menu buttons. The sub layer 
menus then open out to reveal the active buttons. 
 
Figure 46 shows the cascaded menu as shown on the WinControl pane. The 'VTR's' menu 
has been selected revealing the layer of sub menus, Digital Beta, Beta SP etc. At the base 
of the pane is a menu button that returns the display to the top level menu. 
 

'Mid Layer' Menu

Selected Menu Sub Menus

Return - 'Top level' Menu  
Figure 46 
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Selecting one of the sub layer menus, for example 'Digital Beta', reveals the active buttons 
that are associated with that menu, figure 47. 
 
At the base of the pane are two additional menu buttons, 'Source' which returns the 
display to the top layer menu and 'VTRs' which returns the display to the mid layer menu. 
 

'Sub Layer' Menu
Selected Menu Active Buttons

Return - 'Top Layer' MenuReturn - 'Mid Layer' Menu  
Figure 47 

 
9.4.  Panel Configuration 
The menus created in the 'Edit Menus' window can now be used as the base for creating 
the menu and active buttons of the WinControl panel. This section uses the XY panel as 
an example although the task of configuring the various button types is the same for all 
five WinControl panels. 
 
9.4.1.  Set-up the default panel 
 
Step 1: Select the control panel template, in this example the XY panel. The WinControl 
application will load the XY panel with a mapping based on the current set-up information 
stored in the two WinControl .ini files. 
 
Step 2: Enter the panel 'Edit Mode'. Click on 'Edit', select 'Edit Mode' and 'On' and enter 
the password. Once in the edit mode all 'unused' buttons will appear (with no text) along 
with the button selector drop down menus, which are located at the base of the panel, 
figure 48. 

Button Selector  
Figure 48 
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Step 3: At first it is recommended that any current button configurations are removed. This 
is achieved by first selecting the button. A selected button is indicated by a blue box. 
 

Selected button

Button Select  
Figure 49 

 
Next click the 'Button Select 'drop down menu and select 'Unused', figure 49. This will clear 
the current configuration of the selected button. Repeat this process for all of the buttons 
on the pane, for both left and right panes. 
 
9.4.2.  The 'Menu' button 
 
Step 1: Highlight the required location for the menu button. The selected position is 
confirmed by a blue box. 
 
Step 2: Use the 'Button Select' drop down menu to select the required button functionality, 
in this example the 'Menu Key', figure 50. When the button type is selected the name of the 
next unallocated menu is displayed on the button. 
 

Select the 'Menu Key'  
Figure 50 

 
Step 3: Once the button has been configured as a 'Menu Button" an additional drop down 
box appears, figure 51. From this drop down list select the menu that needs to be linked to 
this button, in this example VTRs. The name VTRs will replace the default name that 
appears when the button type was selected. 
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Select the 'Menu'  
Figure 51 

 
The menu button is now created. Repeat this step for additional menu buttons. 
 
Step 4: Click on 'Edit' and then 'Save' to save the new panel configuration. It is 
recommended to repeat the save step as each button is created. 
 
Note: The list of menus that appear in the drop down box are loaded directly from the 
menus created and stored in library of the 'Edit Menus' window, as shown in figure 52. 
 

 
Figure 52 

9.4.2.  The 'Active' button 
 
Step 1: Highlight the required location for the active button. The selected position is 
confirmed by a blue box. 

Selected button

Button Select  
Figure 53 
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Step 2: Use the 'Button Select' drop down menu to select the required button functionality, 
in this example the 'Destination Key', figure 53. When the button type is selected the name 
of the next unallocated destination key is displayed on the button. 
 
Step 3: Once the button has been configured as an 'Active Button" an additional drop 
down box appears, figure 54. From this drop down list select the required link for this 
button. As the button has been configured as a destination the list that appears in the drop 
down menu contains a rundown of the available destinations. The name of the chosen 
destination will replace the default name that appears when the button type was selected. 
 

Select the 'Menu'  
Figure 54 

 
The active button is now created. Repeat this step for additional active buttons. 
 
Step 4: Click on 'Edit' and then 'Save' to save the new panel configuration. Repeat the 
save step as each button is created. 
 
Figure 55 shows one of the panes from the WinControl panel which has been configured 
with a mixture of single and cascaded menu buttons and active buttons. 
 

 
Figure 55 
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9.4.3.  'Short Cut' buttons 
 
To aid in the configuration of the WinControl panel there are a number of 'short cut' 
buttons that can be used. 
 
They are: 
 
 Feature   Short Cut Key 
 

1. Unused   'U' or 'N' 
2. Destination    'D' 
3. Source Preset Key  'R' 
4. Menu Key   'M' 
5. Salvo Key   'V' 
6. Source Key   'S' 
7. Take Key   'T' 
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Section 10 
 
 

Contact details: 
 
 
 
 
 
       Quartz Electronics 
 

       59 Suttons Business Park 
       Reading 
       Berkshire 
       England 
       RG6 1AZ 
 
 
 
 
       Tel: +44 (0)118-935-0200 
 

       Fax: +44 (0)118-935-0202 
 

       Email: sales@quartzuk.com 
 
 
 
 
 
 
 
 
 Web Site:  www.quartzuk.com 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 


